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Overview 
Updating and Displaying Revenue Accounts:  Inquire on revenue accounts by specific account, by partial 

number scan, and by partial number summary. 

Inquiries:  The Revenue Inquiry screen provides an online view of year-to-date (YTD) revenue account 

activity.  On this screen, PCGenesis displays Receivables entered (Rcvb.Entr.) and Receivables closed 

(Rcvb.Clsd) fields which identify the current year’s “in and out” receivable activity.  The net of this activity is 

the Open Receivables (Open Receiv.) amount which excludes prior year receivables still open in the current 

year.  The Receipts field identifies the totals of the current year’s receipts and includes receipts against prior 

year receivables.  PCGenesis automatically updates this amount when the user enters and cancels receipts.  

Deposited receipts however do not affect the Receipts total.  Prior Year Receivables Closed in the Current 

Year (Prior Yr Receivable Closed Cur Yr) identifies the total prior year receivables closed within the current 

year.  PCGenesis calculates the Current Year Revenue (Cur Yr Revenue) by subtracting the prior year 

receivable closed amount from the Receipts total and adding the open receivables total.  The Uncollected 

amount is the Adjusted Estimate (Adj Estimate) subtracted from the Current Year Revenue (Cur Yr Revenue) 

amount.  If this amount is a negative (-) dollar amount, the amount is identified as Excess Collection (Excess 

Col.).  The Revenue column to the right of the screen reflects the current year’s revenue, that is, Receipts + 

Open Current Year Receivables - Closed Prior Year Receivable amounts.  These totals all tie directly back to 

the General Ledger (G/L) report’s activity. 

Additions/Updates:  Create revenue accounts to enter the fiscal year’s revenue.  PCGenesis may automatically 

distribute the original revenue estimate to monthly amounts, or the monthly distribution amounts may be 

entered manually.  All account number “pieces” must exist in the Account Master Description File before 

creating the account record by using these procedures.  Refer to Section K:  Account Master Description File 

Processing for instructions. 

All revenue account additions, modifications, and deletions generate entries in the AUDIT file and on the 

General Ledger (G/L).  The G/L entry debits or credits the appropriate accounts.  PCGenesis does not allow 

the deletion of revenue accounts unless the Adjusted Revenue Estimate and the Original Revenue Estimate are 

zero.  Although PCGenesis does not allow modifications to closed revenue accounts, view these accounts as 

needed. 

Printing the Revenue Chart of Accounts:  The Revenue Chart of Accounts provides a listing of active 

revenue accounts for a specific date range.  These accounts display with the original and/or current 

revenue amounts, and/or the current balances.  Closed accounts may also be included in this listing of 

accounts.  This procedure will also create a revenue account Export file for processing via Microsoft® 

Excel, where applicable. 

The printing the Revenue Chart of Accounts procedure will also create a revenue account Export file 

which can be used by the Revenue Load from External File procedure to create a new fiscal year’s chart 

of accounts and revenue entries.  This can be done by printing the Revenue Chart of Accounts and 

selecting the radio button corresponding to Export for New Fiscal Year REVENUE LOAD in the 

Create EXPORT File to load in Excel field.  Selecting the revenue account Export file for a new fiscal 

year creates the new fiscal year’s revenue, based on the current year’s revenue account information.   
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PCGenesis performs the following during this process: 

 After the Export for New Fiscal Year REVENUE LOAD option is selected, the user specifies the 

New Fiscal Year and the % Revenue Change values.  For example, users may apply a formula to 

each revenue account to increase the revenue amount by 3%.  If the new fiscal year’s revenue 

estimate remains unchanged from the prior fiscal year, the % Revenue Change value can be set to 

zero. 

 The Export for New Fiscal Year REVENUE LOAD process exports the current fiscal year’s 

revenue accounts and amounts from PCGenesis, applies the % Revenue Change factor, and 

calculates a New Revenue amount for each account.  The export process creates a Comma 

Separated Value (.csv) file.  The .csv file can be loaded into Microsoft® Excel for further editing if 

additional modifications are needed for the revenue account numbers or revenue estimates. 

 After saving the Microsoft® Excel spreadsheet as a comma delimited (.csv) file, and after using the 

PCGenesis Import procedure to upload the information, the user must verify the revenue figures for 

accuracy. 

Performing the Revenue Account Upload:  Performing the Revenue Account Upload creates the new 

fiscal year’s chart of accounts and revenue estimates based on the contents of a Comma Separated Value 

(.csv) import file.  The import file must contain the following information for each general ledger 

account:  the revenue general ledger account number, the balance sheet account code, the account 

description or title, and the revenue amount. 

 

Summary of Revenue Account Add/Update Options 

Add Revenue Account 

 Refer to Topic 2:  Adding a Revenue Account in this document 

 When an account does not exist, use F1 to add 

 Enter Original Estimate field 

 Optional:  Allocate the Original Estimate over the 12 months, or allow the system to 

automatically allocate the Original Estimate over the 12 months 

 Fill in other fields as necessary 

 ENTER twice to post 

 Outcome:  The Adj. Estimt (Adjusted Estimate) field is replaced by the amount entered in the 

Enter Original Estimate field 

 Outcome:  The Orig. Estimt (Original Estimate) field is replaced by the amount entered in the 

Enter Original Estimate field 

 Outcome:  The Enter Original Estimate amount is allocated over the 12 months 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  3:42 PM  Page 3 of 63 

All Rights Reserved. 

Update Revenue Account - Update Adjusted Estimate 

 Refer to Topic 3:  Updating Revenue Account Information in this document 

 The account must exist 

 Optional:  Enter Adj. to Estimate (Adjustment to Estimate) field 

 Required if Adjustment to Estimate field entered:  Allocate the Adjustment to Estimate 

amount over the 12 months 

 Update other fields as necessary 

 ENTER twice to post 

 Outcome:  The Adj. Estimt (Adjusted Estimate) field is increased (positive adjustment) or 

decreased (negative adjustment) by the amount entered in the Adjustment to Estimate field 

 Outcome:  The Orig. Estimt (Original Estimate) field remains unchanged 

 Outcome:  The Distribution by Month fields are increased (positive adjustment) or decreased 

(negative adjustment) by the amounts shown on the screen 

 

Update Revenue Account - Update Adjusted Estimate and Original Estimate 

 Refer to Topic 3:  Updating Revenue Account Information in this document 

 The account must exist 

 Optional:  Enter Adj. to Estimate (Adjustment to Estimate) field 

 Optional:  Allocate the Adjustment to Estimate amount over the 12 months, or allow the 

system to automatically allocate the Adjustment to Estimate amount over the 12 months 

 Update other fields as necessary 

 Select F31 to Adjust Original Balance, and then ENTER to post 

 Outcome:  The Adj. Estimt (Adjusted Estimate) field is increased (positive adjustment) or 

decreased (negative adjustment) by the amount entered in the Adjustment to Estimate field 

 Outcome:  The Orig. Estimt (Original Estimate) field is increased (positive adjustment) or 

decreased (negative adjustment) by the amount entered in the Adjustment to Estimate field 

 Outcome:  The Distribution by Month fields are increased (positive adjustment) or decreased 

(negative adjustment) by the amounts shown on the screen 
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Upload Chart of Accounts and select ORIGINAL upload option 

 Refer to Topic 6:  Importing the Microsoft® Excel Revenue.csv File into PCGenesis, 6B. 

Revenue Load from External File in this document 

 The account may or may not exist.  If the account does not exist, it will be automatically created 

by the system. 

 Required:  Column K - Revenue Amount must be entered in the .csv upload file 

 Enter all other required fields in the .csv upload file 

 Select the ORIGINAL upload option 

 Outcome:  The Adj. Estimt (Adjusted Estimate) field is replaced by the amount entered in 

Column K - Revenue Amount 

 Outcome:  The Orig. Estimt (Original Estimate) field is replaced by the amount entered in 

Column K - Revenue Amount 

 Outcome:  The Column K - Revenue Amount is automatically allocated over the 12 months 

and replaces the prior monthly allocations 

 

Upload Chart of Accounts and select ADJUST upload option 

 Refer to Topic 6:  Importing the Microsoft® Excel Revenue.csv File into PCGenesis, 6B. 

Revenue Load from External File in this document 

 The account must exist 

 Required:  Column K - Revenue Amount must be entered in the .csv upload file 

 Enter all other required fields in the .csv upload file 

 Select the ADJUST upload option 

 Outcome:  The Adj. Estimt (Adjusted Estimate) field is replaced by the amount entered in 

Column K - Revenue Amount field 

 Outcome:  The Orig. Estimt (Original Estimate) remains unchanged 

 Outcome:  The Column K - Revenue Amount is automatically allocated over the 12 months 

and replaces the prior monthly allocations 

 

Performing the Fiscal Year Revenue Account Rollover:  When PCGenesis users “roll” revenue account 

activity to the new fiscal year PCGenesis transfers active revenue account activity to the upcoming fiscal year. 

Refer to the Financial Accounting and Reporting (FAR) System Operations Guide, Section J:  Financial 

Reporting and Closing, Topic 1A:  Processing Annual/Fiscal Year-End Closing Reports for the procedures to 

run additional revenue account activity reports.  

Screen Print:  The screen print feature allows the user to obtain a screen print of the revenue account inquiry 

screen.  The screen print feature is available on Revenue Account Master screens which have the  (F17 

– Print Screen) button.  The screen print file will be available in the print queue with the name ‘PSCNnnnn’. 

Drop-Down Selection Icon Feature: Certain fields within PCGenesis contain the drop-down selection icon 

 to aid in the entry of field information.  When used, double-select the desired information to complete the 

entry.   
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Topic 1:  Inquiring on a Revenue Account 
Step Action 

1  From the Business Applications Master Menu, select  (F1 - Financial Accounting & 

Reporting System). 

The following screen displays: 

 

Step Action 

2  Select  (F5 - Revenue Account Master Menu). 

 

  



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  3:42 PM  Page 6 of 63 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

3  Select  (F1 - Account Inquiry). 
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The following screen displays: 

 

Step Action 

4  Option 1 to recall a specific account:  Enter or select the drop-down selection icon  in 

the Yr Fnd F Prgm Fnct Objct Fcty B Addt'l field to choose the account, and select  

(Enter). 

Option 2 to scan all matching line items:  Enter the partial account information in the Yr 

Fnd F Prgm Fnct Objct Fcty B Addt'l field, and select  (F2 – Scan).  (If no entry is 

made, PCGenesis defaults to ‘00’.)’ 

Option 3 to summarize all matching line items:  Enter the partial account information in 

the Yr Fnd F Prgm Fnct Objct Fcty B Addt'l field, and select  (F3 – Summarize). 

PCGenesis displays “*** RECORD NOT FOUND***” displays for nonexistent revenue 

account entries. Reenter the account number and select  (Enter), or select  (F16 

- Exit). 
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The following screen displays: 

 

Step Action 

5  Review and/or screen-print the Revenue Inquiry screen’s information. 

If desired, select  (F17 – Print Screen) to obtain a screen print of the revenue account 

inquiry screen.  The screen print file will be available in the print queue with the name 

‘PSCNnnnn’. 

Select  (F1 - Next) and  (F2 - Previous) when offered to scroll between records.  

If selecting  (F1 - Next), to view additional Revenue account information, continue to 

select  (Enter) until the appropriate account is located or until the “***END OF 

FILE***” message displays.   

6  Select  (F16 - Exit) to return to the Account Inquiry Entry/Selection screen. 

 

  

Revenue account 

activity indicators 
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The following screen displays: 

 

Step Action 

7  Select  (F16 - Exit) to return to the Financial Accounting & Reporting - Revenue 

Account Master Menu. 
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The following screen displays: 

 

Step Action 

8  Select  (F16 - Exit) to return to the Financial Accounting & Reporting Master Menu, or 

select  (Master) to return to the Business Applications Master Menu. 
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Topic 2:  Adding a Revenue Account 

 

Step Action 

1  Select  (F5 - Revenue Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F2 - Account Add/Update). 
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The following screen displays: 

 

Step Action 

3  Select the drop-down selection icon  or enter the account information in the Yr Fnd F 

Prgm Fnct Objct Fcty B Addt'l field, and select  (Enter). 
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For nonexistent revenue accounts, the following screen displays: 

 

Step Action 

4  Verify “*** Record Not Found***” displays, select  (F1 - to Add). 
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For nonexistent revenue accounts, the following screen displays: 

 

Step Action 

5  Enter the effective date (MM/DD/CCYY) in the Tran Date (Transaction Date) field. 

The Tran Date (Transaction Date) determines when the transaction occurs.  Although 

PCGenesis defaults to the current date, it is recommended that the transaction date be 

changed so that the transaction date and the begin date are identical.  Some reports, 

including the DE0046 and DE0396, will not include the account information if the report is 

created with a date that is prior to the transaction date, even though the begin date falls 

within the report range. 

6  Enter the date range (MM/DD/CCYY) in the Beg Date (Beginning Date) and End Date 

(Ending Date) fields. 

The account will be active for the date range entered. 

7  Enter the fund balance account in the Fund Balance Acct (Fund Balance Account) field. 

8  Enter the amount in the Enter original estimate field. 

9  Enter the reason for the creation of the account in the Reason field where appropriate. 

10  Enter the account name up to thirty (30) characters in the Title field. 

If there is not an entry the Title field, PCGenesis will automatically default to the title of the 

previous year’s account name if it exists. 

  

This date 
determines when 
the transaction 

appears on reports.  
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Step Action 

11  To manually enter the monthly amounts:  Enter the account’s monthly total in the Enter 

Distribution by Month field and select  (Enter  - to Process) once. 

To allow PCGenesis to automatically distribute the monthly amounts:  Select  (Enter) 

once. 

PCGenesis redisplays the Revenue Add screen with amounts equally distributed over the months. 

Select  (F17 – Print Screen) to obtain a screen print of the Revenue Add screen.  The screen 

print file will be available in the print queue with the name ‘PSCNnnnn’.     

The following screen displays: 

 

Step Action 

12  Verify the amounts are correct and select  (Enter - to Post). 

If the information is incorrect, select  (F16) to enter the correct information and select 

 (Enter) twice. 

 

  

PCGenesis account 
distribution 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  3:42 PM  Page 17 of 63 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

13  Select  (F16 - Exit) to return to the Financial Accounting & Reporting - Revenue 

Account Master Menu. 
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The following screen displays: 

 

Step Action 

14  Select  (F16 - Exit) to return to the Financial Accounting & Reporting Master Menu, or 

select  (Master) to return to the Business Applications Master Menu. 
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Topic 3:  Updating Revenue Account Information 

 

Step Action 

1  Select  (F5 - Revenue Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F2 -Account Add/Update). 
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The following screen displays: 

 

Step Action 

3  Select the drop-down selection icon  or enter the account information in the Yr Fnd F 

Prgm Fnct Objct Fcty B Addt'l field, and select  (Enter). 
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The following screen displays: 

 

Step Action 

4  To update a Revenue account:  Proceed to Step 5. 

To adjust a Revenue account’s estimated revenue:  Proceed to Step 6. 

To adjust the original balance of a Revenue account:  Proceed to Step 7. 

To delete a Revenue account:  First the account’s estimated revenue must be set to zero 

before the account can be deleted (Step 6).  Once the estimated revenue for the account has 

been set to zero, proceed to Step 8. 

Select  (F17 – Print Screen) to obtain a screen print of the Revenue Update screen.  

The screen print file will be available in the print queue with the name ‘PSCNnnnn’. 
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Step Action 

5  To update a Revenue account:  Make the appropriate entries in the following fields, and select 

 (Enter) twice. 

 Tran Date (Transaction Date) 

The Tran Date (Transaction Date) determines when the transaction occurs.  Although 

PCGenesis defaults to the current date, it is recommended that the transaction date be 

changed so that the transaction date and the begin date are identical.  Some reports, 

including the DE0046 and DE0396, will not include the account information if the 

report is created with a date that is prior to the transaction date, even though the begin 

date falls within the report range. 
 

 Beg Date (Beginning Date) – Enter the date the account will become active. 

 End Date (Ending Date) – Enter the last date the account will remain active. 

 Fund Balance Acct (Fund Balance Account) 

 Enter Adj. To Estima (Enter Adjustment to Estimate) – Enter the dollar amount. 

 Reason – Enter the reason for the modification, where applicable. 

 Title – Enter the description of the account, where applicable. 

Proceed to Step 9. 

6  To adjust a Revenue account’s estimated revenue: 

On the Revenue Account Record Update screen, select the appropriate option below: 

 To decrease the amount:  Enter the negative (-) amount of the Adj. Estimt field in the Enter 

Adj. To Estima (Enter Adjustment to Estimate) field.   

 To increase the amount:  Enter the amount in the Enter Adj. To Estima (Enter Adjustment 

to Estimate) field.   

The distribution amount in the Enter Adj. To Estima field must be manually distributed in 

any combination of months, or assigned to a specified month as long as the monthly entries 

equal the amount entered in the Enter Adj. To Estima field. 

 To modify the revenue distribution:  Enter the amount in the distribution month’s Amount 

field(s), where applicable.  

Proceed to Step 9. 
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Step Action 

7  To adjust a Revenue account’s original balance: 

On the Revenue Account Record Update screen, select the appropriate option below: 

 To decrease the amount:  Enter the negative (-) amount of the Adj. Estimt field in the Enter 

Adj. To Estima (Enter Adjustment to Estimate) field.   

 To increase the amount:  Enter the amount in the Enter Adj. To Estima (Enter Adjustment 

to Estimate) field.   

The distribution amount in the Enter Adj. To Estima field must be manually distributed in 

any combination of months, or assigned to a specified month as long as the monthly entries 

equal the amount entered in the Enter Adj. To Estima field. 

 To modify the revenue distribution:  Enter the amount in the distribution month’s Amount 

field(s), where applicable.  

To adjust the Original Balance: Press  (F31) to adjust the original balance. 

The “Original Balance Adjusted, Enter to Post, F16 to Reenter” message displays.   

Press  (Enter) once and proceed to Step 10. 

8  To delete a Revenue account: 

Verify zero exists in the Adj. Estima (Adjusted Revenue Estimate) field. 

Select  (F12 - Delete), and  (F28 - to confirm delete) to complete the record 

deletion. 

Proceed to Step 10. 

9  Select  (Enter) twice. 
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The following screen displays: 

 

Step Action 

10  Select  (F16 - Exit) to return to the Financial Accounting & Reporting - Revenue 

Account Master Menu. 
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The following screen displays: 

 

Step Action 

11  Select  (F16 - Exit) to return to the Financial Accounting & Reporting Master Menu, or 

select  (Master) to return to the Business Applications Master Menu. 
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Topic 4:  Printing the Revenue Account Chart of Accounts 
Also run the Revenue Chart of Accounts by selecting F9 (Financial Reporting and Month/Yr-End Close 

Menu) → F3 (Revenue Account Master Reports Menu) →F10 (Revenue Master:  Chart of Accounts).  This 

procedure and the corresponding screenshots are the same as those presented here. 

 

Step Action 

1  Select  (F5 - Revenue Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F3 - Chart of Accounts). 
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The following screen displays: 

 

Step Action 

3  Enter the date range (MM/DD/CCYY) in the Beginning Date and Ending Date fields. 

4  To include closed Revenue accounts:  Enter C (Closed accounts) in the To allow CLOSED 

accounts to be printed, enter a 'C' here field. 

5  Enter X in the Original Estimate, Current Estimate, and/or Current Balance field(s) to define 

the type of revenue items. 

6  Enter the appropriate response in the Printing each fund on a separate page field. 

7  
To print the Chart of Accounts only:  Select the radio button corresponding to None in the 

Create EXPORT File to load in Excel field, and proceed to Step 10. 

To print the Chart of Accounts, and to create a Microsoft Excel file:  Select the radio 

button corresponding to Export Current Fiscal Year in the Create EXPORT File to load in 

Excel field, and proceed to Step 8. 

To print the Chart of Accounts, and to create a Microsoft Excel file to be used for 

Revenue Load:  Select the radio button corresponding to Export for New Fiscal Year 

REVENUE LOAD in the Create EXPORT File to load in Excel field, and proceed to Section 

5B.1. Printing the Revenue Chart of Accounts for Revenue Load. 
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For Step 7- Create EXPORT File to load in Excel entries, the following screen displays: 

 

Step Action 

8  Verify the C:\PCG folder exists, or create the folder where appropriate. 

9  Enter C:\PCG\REVCHARTEXPT.csv in the Enter File Name and Path for Export File 

field, or select  (F10 to Browse for file) to locate the file manually. 

10  Select  (Enter) twice. 

“** Processing Request **” briefly displays. 
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The following screens displays: 

 

Step Action 

11  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

12  Select  (F16 - Exit) to return to the Payroll System Master Menu, or select  

(Master) to return to the Business Applications Master Menu. 

If creating an export file in Step 7 for the purpose of loading a new fiscal year budget, 

proceed to Topic 5:  Preparing the Import File for the Revenue Upload. 
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4A. Revenue Chart of Accounts – Example 

 

The final page of the report completes the listing of revenue accounts and totals, and provides an overall total 

for all funds. 
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Topic 5:  Preparing the Import File for the Revenue Upload 

5A. Revenue Account Export & Import Checklist 

  STEP ACTION 

 1  Create a folder entitled PCG, or verify the folder exists on the C:\ drive of your Personal 

Computer (PC). 

 2  Verify the school district’s Highest Allowable Transaction Date is greater than or is equal 

to the current fiscal year.  Refer to Section N:  Special Functions, Topic 1:  

Displaying/Updating System Control Information for instructions. 

 3  Verify all account pieces including the year, funds, programs, and sources, are valid in 

the Account Master Description File.  Refer to Section K:  Account Master 

Description File for instructions. 

 4  If performing a Revenue Adjustment import:  Define the account in the PCGenesis 

Revenue Chart of Accounts. 

 5  Print the Revenue Chart of Accounts for the new fiscal year.  This listing will be used for 

comparison purposes with the results of the revenue import. 

 6  Create the PCGenesis Export file by printing the Revenue Chart of Accounts and selecting 

the radio button corresponding to Export for New Fiscal Year REVENUE LOAD in the 

Create EXPORT File to load in Excel field. 

 7  Delete Fund 199 Balance Sheet accounts in the Microsoft Excel spreadsheet before 

beginning the Import procedure. 

 8  Edit the Microsoft Excel spreadsheet before beginning the Import procedure.  

Correct errors resulting from invalid account numbers within PCGenesis, and on the 

Microsoft® Excel spreadsheet.  After correcting resulting errors, repeat the Import 

procedure.  Verify and finalize all revenue entries. 

 9  Perform a PCGenesis Data backup. 

 10  Import the .csv file created from the Microsoft® Excel Import file into PCGenesis. 

 11  Print the Revenue Chart of Accounts for the new fiscal year.  Compare these results to 

the listing created before performing the Import in Step 5. 

  

http://techservices.doe.k12.ga.us/admin/support/finaccountreportoperationsguide.htm
http://techservices.doe.k12.ga.us/admin/support/finaccountreportoperationsguide.htm


PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  3:42 PM  Page 34 of 63 

All Rights Reserved. 

5B.  Revenue Account Export & Import 

5B.1. Printing the Revenue Chart of Accounts for Revenue Load 

Also run the Revenue Chart of Accounts by selecting F9 (Financial Reporting and Month/Yr-End Close 

Menu) → F3 (Revenue Account Master Reports Menu) →F10 (Revenue Master:  Chart of Accounts).  This 

procedure and the corresponding screenshots are the same as those presented here. 

 

Step Action 

1  Select  (F5 - Revenue Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F3 - Chart of Accounts). 

 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  3:42 PM  Page 36 of 63 

All Rights Reserved. 

The following screen displays: 

 

Step Action 

3  Enter the date range (MM/DD/CCYY) in the Beginning Date and Ending Date fields. 

4  To include closed Revenue accounts:  Enter C (Closed accounts) in the To allow CLOSED 

accounts to be printed, enter a 'C' here field. 

5  Enter X in the Original Estimate, Current Estimate, and/or Current Balance field(s) to define 

the type of revenue items. 

6  Enter the appropriate response in the Printing each fund on a separate page field. 

7  To print the Chart of Accounts and to create a Microsoft Excel file to be used for 

Revenue Load:  Select the radio button corresponding to Export for New Fiscal Year 

REVENUE LOAD in the Create EXPORT File to load in Excel field. 

8  Select  (Enter) to continue. 
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The following screen displays: 

 

Step Action 

9  Verify the C:\PCG folder exists, or create the folder where appropriate. 

10  Enter C:\PCG\REVCHARTLOAD.csv in the Enter File Name and Path for Export File 

field, or select  (F10 to Browse for file) to locate the file manually. 

11  Enter the fiscal year to be loaded during the Revenue Load from External File process in the 

New Fiscal Year field. 

12  Enter the revenue increase or decrease percentage in the % Revenue Change field.  The 

percentage entered may be positive or negative.  Enter percentages as whole numbers.  For 

example 5.25% is entered as 5.25. 

13  Select  (Enter). 

“** Processing Request **” briefly displays. 
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The following screens displays: 

 

Step Action 

14  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to 

create the macro necessary to use the feature where appropriate. 

15  Select  (F16 - Exit) to return to the Payroll System Master Menu, or select  

(Master) to return to the Business Applications Master Menu. 
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5B.2. Creating the Microsoft® Excel Import File with the New 

Fiscal Year’s Revenue Amounts 

The Creating the Microsoft® Excel Import File procedure formats the Export file created in Topic 5B.1:  

Printing the Revenue Chart of Accounts for Revenue Load, and creates the new fiscal year’s revenue.  

Modify the export files by using these instructions. 

This document provides detailed instructions for the creation of the new fiscal year’s revenue based on 

prior year amounts via Microsoft® Excel.  Instructions are also provided for saving the results in a 

Comma Separated Value (.csv) file suitable for the Revenue Load from External File procedure. The 

following columns are required for the Comma Separated Value (.csv) import file: 

 Column A - Fiscal Year 

 Column B - Fund 

 Column C - Fisc Indicator 

 Column D - Program Code 

 Column E - Revenue Source Code 

 Column F - Object Code 

 Column G - Facility 

 Column H - Building Code 

 Column I - Additional Code 

 Column J - Balance Sheet Account 

 Column K – New Revenue Amount  (NEW BUDG column heading) 

 Column L – Description 

An additional column M with the heading CURRENT is included in the .csv file to aid in the analysis 

of the revenue figures.  For your calculations, you may also wish to create additional formulas.  The 

CURRENT column (M) will be ignored during the import process. 

During the export process, the user specifies the percentage revenue increase or decrease by entering a 

percentage into the % Revenue Change field.  Valid percentages are either positive or negative values.  

During the export process, the PCGenesis system extracts the current revenue figures based upon the 

Beginning date and Ending date entered on the input screen, and applies the % Revenue Change 

percentage in order to create the New Revenue Amount column (K).  The current revenue amount upon 

which the calculation is based is extracted into the CURRENT column (M) for reference only. 

The export process may be run as many times as necessary, with as many different % Revenue Change 

values as desired, until a satisfactory upload file is created.  The new revenue amounts may also be 

manually adjusted individually where appropriate when editing the file in Microsoft® Excel as 

described below. 

Based on the version of software used, file extensions such as Excel Workbook (*.xlsx), Excel 97-2003 

Workbook (*.xls), Comma delimited (*.csv), and Excel 97-2003 Template (*.xlt), for example, may 

contain descriptions that differ from this document’s instructions.  Ensuring that the filename 

description selected, such as “Workbook”, “Spreadsheet”, and “.csv File”, corresponds to the file type 

indicated within the instructions, prevents additional processing errors. 
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***IMPORTANT*** 

Do not enter commas (,) in any of the Microsoft® Excel spreadsheet’s data fields as doing so creates 

incompatibilities with the .csv file’s format. 

 
The following instructions create a new fiscal year’s revenue based on the current fiscal year’s revenue 

amount. 

 

Step Action 

1  Open Microsoft® Excel. 

2  Navigate to C:\PCG. 

 

The following window displays: 

 

Step Action 

3  Click on the drop-down selection icon    in the Files of type field, and select All Files 

(*.*). 
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The following window displays: 

  

 

Step Action 

4  Click once on REVCHARTLOAD.csv and click Open . 

If using a different filename during the file’s creation, select the appropriate file. 

Click once here, 

and click Open. 
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 The following screen displays: 

 

 

Step Action 

5  Delete the appropriate row(s) to exclude Fund 199 and all other accounts for which the user will 

not enter revenues. 

To delete a row, click once on a cell within the row containing unwanted accounts, or the 

appropriate account line.  From the Menu Bar, select Edit → Delete.  If the Delete Selection 

dialog box displays, click once on the radio button to the left of Entire row , and 

click OK  . 
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* * * Attention * * * 

Steps 6– 16 are OPTIONAL and are included for your information to use as needed. 

Step Action 

6  To adjust the columns:  Select the appropriate columns.  With the columns selected, from 

the Menu Bar, select Format → Column → AutoFit Selection. 

7  OPTIONAL 

Save the spreadsheet as a Microsoft® Excel Workbook (*.xls) if extensive changes are 

required to the New Revenue Amount values. 

8  To format the amounts within the inserted column:  Select the appropriate column by 

selecting once within the column.  From the Menu Bar, select Format → Cells.  Within the 

Format Cells dialog box, select the Number tab, and select Number from the Category column.  

Enter 2 in the Decimal places field and select  (OK). 

9  To format the width of the inserted column:  Select the appropriate column by selecting once 

within the column.  From the Menu Bar, select Format → Columns→ AutoFit Selection. 

10  Edit the Microsoft Excel spreadsheet before beginning the Import procedure.  Verify and 

finalize all budget entries. 

11  To change the fiscal year (YR) field:  Enter the two-digit year in Row A2 and select Enter.  

For example, enter 12 for FY12.  With Cell A2 selected, select Copy  .  A moving border will 

surround the cell’s contents.  Position the cursor within Row A3 of the column.  Select the 

remaining cells within the column by continuing to hold down the SHIFT key to the last cell 

within the column.  With all cells within the column selected, select Enter. 

You may also incorporate more creative sort options into the spreadsheet to verify revenue 

amounts and to add more columns and totals.  Regardless of the purpose, all formulas must be 

converted into values before the file is imported into PCGenesis. 
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Step Action 

12  Where applicable refer to Appendix B:  Revenue .csv File Formatting/Processing for the columns’ 

edit rules.  It is not necessary to format column widths and decimal positions.   

The following columns are required for the import: 

 Column A - Fiscal Year 

 Column B - Fund 

 Column C - Fisc Indicator 

 Column D - Program Code 

 Column E - Revenue Source Code 

 Column F - Object Code 

 Column G - Facility 

 Column H - Building Code 

 Column I - Additional Code 

 Column J - Balance Sheet Account 

 Column K - Revenue Amount 

 Column L – Description 

13  OPTIONAL 

Verify you have followed the instructions in Step 7 to save your file as a Workbook (*.xls) file.  

Saving the file in this format will facilitate future changes and makes it easier to recall the 

spreadsheet as needed. 

To save the file as a Microsoft Excel Workbook (*.xls) file for import into PCGenesis:  

From the Menu Bar, select File → Save As.  When the Save As dialog box displays, enter 

C:\PCG\REVENUEyy.XLS, where yy is the two-digit fiscal year, in the Filename field.  

Click on the drop-down selection icon    in the Save as type field and verify Microsoft 

Excel Workbook (*.xls) has been selected.  Click Save . 

14  REQUIRED 

Save the file as a .csv file to ensure the file is correctly formatted for import into PCGenesis. 

From the Menu Bar, select File → Save as.  When the Save As dialog box displays, enter 

C:\PCG\REVENUEyy.CSV in the Filename field where yy is the two-digit fiscal year.  This 

filename will be selected in 6B. Revenue Load from External File.   

Select the drop-down selection icon   in the Save as type field and verify CSV (Comma 

delimited) (*.csv) has been selected and select  (Save).  When the Do you want to 

keep the workbook in this format? dialog box displays, select  (Yes). 

At this point, the “CURRENT” Revenue information exists within the new fiscal year revenue 

spreadsheet as a .csv file.  After making the modifications reflecting the new fiscal year’s dollar 

amounts, import the data into PCGenesis. 

15  Close Microsoft® Excel. 
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Step Action 

16  When the Do you want to save your changes? dialog box displays, select  (No). 

This prompt will always be displayed when exiting Microsoft® Excel after saving a file in 

the .csv format. 
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Topic 6:  Importing the Microsoft Excel Revenue.csv File into 

PCGenesis 

6A. Performing a PCGenesis Data Backup 

 
 

* * * ATTENTION * * * 

 

Performing a Data backup before the beginning of the import of revenue account 

information into PCGenesis is strongly encouraged. 
 

Step Action 

1  Log out of PCGenesis. 

2  Make sure all other users are log out of PCGenesis. 

3  Close Uspool at the server. 

4  Perform a PCGenesis full backup to CD or DVD. 

5  When the PCGenesis backup completes, label the backup media “PCG Data Backup 

BEFORE Revenue Import - MMDDCCYY”. 

6  Maintain the Data backup media and the Backup Log until completing the Import, and 

verifying the resulting Chart of Accounts. 
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6B. Revenue Load from External File 

 

Step Action 

1  Select  (F5 - Revenue Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F4 - Revenue Load from External File). 
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The following screen displays: 

 

Step Action 

3  Select  (F10 - Browse for file), and locate the REVENUEYY.csv file saved in 5B.2. 

Creating the Microsoft® Excel Import File with the New Fiscal Year’s Revenue Amounts. 

4  Enter ORIGINAL or ADJUST (Adjustment) in the Use data to set original revenue or to 

enter revenue adjustment field. 

To enter a revenue adjustment, an original revenue account must exist. 

5  Enter a description for the revenue upload in the reason desc field. 

6  Enter, or verify the desired fiscal year has defaulted correctly, for example 16 for FY16, in 

the Budget Yr (Budget Year) field. 

7  Enter, or verify the fiscal year has defaulted correctly in the Tran Date (Transaction Date) field. 

The Tran Date (Transaction Date) determines when the transaction occurs.  PCGenesis defaults 

to the first day of the fiscal year.  It is recommended that if the begin date is changed, the 

transaction date should also be changed so that the transaction date and begin date are identical.  

Some reports, including the DE0046 and DE0396, will not include the account information if the 

report is created with a date that is prior to the transaction date, even though the begin date falls 

within the report range. 
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Step Action 

8  Enter the fiscal year’s date range (MM/DD/CCYY), for example 07/01/2015 and 06/30/2016 

for FY16, in the Beg Date (Beginning Date) and End Date (Ending Date) fields. 

9  Verify the screen’s entries are correct, and select Enter (Continue). 

 

For import file errors, the following screen displays: 
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For successful file imports, the following screen displays: 

 

Step Action 

10  For import file errors:  Select Enter (to Continue).  Access the PCGenesis Uqueue Print 

Manager to print the report.  Within the Microsoft® Excel spreadsheet, correct the errors 

identified, and repeat this procedure beginning at Step 3. 

Appendix A: Revenue File Scan Error Processing provides additional information on 

interpreting the errors.  View a sample of the report in appendix A2. Revenue Load Error 

Report – Example. 

For successful file imports:  Verify the total dollar amount in the Total revenue amount to be 

loaded is field is correct. 

If the dollar amount is correct:  Enter Y (Yes) in the Continue Y/N? field and select  

(Enter). 

If the dollar amount is incorrect:  Enter N (No) Continue Y/N? field and select  

(Enter).  Check the import file for duplicate accounts etc., and ensure that the decimal (.) is 

in the correct position for the imported amounts. 
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The following screen displays: 

 

Step Action 

11  Select Enter (to Continue). 

“Loading Revenue Amounts” briefly displays, and PCGenesis updates the appropriate dollar 

amounts. 
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The following screen displays: 

 

Step Action 

12  
To print the report via the Uqueue Print Manager:  Select  (Uqueue). 

To print the report via Microsoft® Word:  Select  (MS WORD). 

Follow the instructions provided in the Technical System Operations Guide, User Interface 

Procedures, Creating the Microsoft®-PCGenesis QWORD Macro for Report Printing to create 

the macro necessary to use the feature where appropriate. 

13  Select  (F16 - Exit) to return to the Financial Accounting & Reporting Master Menu, or 

select  (Master) to return to the Business Applications Master Menu. 

14  To compare the Revenue Chart of Account’s results from before the Import (Load) to the 

results after the Import (Load):  Repeat the procedures in Topic 4:  Printing the Revenue Chart 

of Accounts.  Print the report for the PCGenesis import year. 

If the results are incorrect, contact the Technology Management Customer Support Center for 

assistance. 

15  Close Microsoft® Excel where appropriate. 



PCGenesis Financial Accounting and Reporting (FAR) System Operations Guide 

Georgia Department of Education 

September 3, 2015  3:42 PM  Page 54 of 63 

All Rights Reserved. 

 

6B.1. Revenue Load Error Report (Corrections Required) - Example 

 

6B.2. Revenue Load Error Report (Successful Upload) – Example 
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Topic 7:  Performing the Fiscal Year Revenue Account Rollover 

 

Step Action 

1  Select  (F5 - Revenue Account Master Menu). 
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The following screen displays: 

 

Step Action 

2  Select  (F7 - Fiscal Year Account Rollover). 
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The following screen displays: 

 

Step Action 

3  Enter the date range (MM/DD/CCYY) in the Begin date and End date fields. 

4  Select Enter (Continue). 
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The following screen displays: 

 

Step Action 

5  Verify the screen’s entries are correct and select Enter in response to the “Is above data 

correct?” message. 

“***Processing Request***” briefly displays. 

If the information is incorrect, select F16 to enter the correct the information and select 

Enter. 
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The following screen displays: 

 

Step Action 

6  Select  (F16 - Exit) to return to the Financial Accounting & Reporting Master Menu, 

or select  (Master) to return to the Business Applications Master Menu. 
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Appendix A:  Revenue File Scan Error Processing 
If the .csv revenue file contains invalid data, the file upload will generate a Revenue Load Error 

Report in the PCGenesis Uqueue Print Manager.  These errors will include the input file’s line 

number, the error type, and the field in which the error occurred.  If the program detects over 100 

errors in a row, processing will halted.  Usually, repetitive errors are a sign of formatting issues or 

basic oversight in the data, such as leaving out a necessary column.  Compare the error(s) identified 

to the .csv file’s spreadsheet to determine the appropriate corrective measures.  This document 

includes error message examples and the spreadsheet generating the error messages on the following 

pages. 

A1. Revenue Import File Error Message Screenshot Example 
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A2. Revenue Load Error Report - Example 
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A3. Microsoft® Excel Spreadsheet – Example 
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Appendix B:  Revenue .csv File Formatting/Processing 
Use the following information for technical reference for additional flexibility when creating the revenue 

.csv file and to gain a better understanding of .csv file processing. 

Revenue .csv File Format Requirements 

1  When creating the .csv file, the Revenue Import processes all lines except completely blank 

lines, and lines with YR in Column A, or FND in Column B.  The check for YR and FND allow 

the program to skip the header line. 

2  Column A, (account Year) may contain up to 2 digits. 

3  Column B, (account Fund) may contain up to 3 digits. 

4  Column C, (account Fisc indicator) may contain 1 digit. 

5  Column D, (account Program) may contain up to 4 digits. 

6  Column E, (account Source) may contain up to 4 digits. 

7  Column F, (account Object) may contain up to 5 digits. 

8  Column G, (account Facility) may contain up to 4 digits. 

9  Column H, (account Building code) may contain 1 digit. 

10  Column I, (account Additional code) may contain up to 6 digits. 

 The account number represented by Columns A through I must be a valid account in the Revenue 

(or Revenue) Chart of Accounts, if the processing mode is ADJUST. 

 The account number pieces represented by Columns A through I must be valid in the Account 

Master Description File, if the processing mode is ORIGINAL.  PCGenesis creates the account if 

it does not already exist. 

11  Column J, (Balance Account) may contain up to 4 digits. 

12  The amount entries within Column K must meet the following specifications: 

 12.1 May contain up to 9 significant digits before the decimal. 

 12.2 May contain 1 decimal point. 

 12.3 May contain up to 2 digits following the decimal. 

 12.4 May contain either a leading or trailing negative (-) sign. 

 12.5 May contain a leading $ sign. 

 12.6 May contain leading zeroes (0’s) or spaces before the significant digits. 

 12.7 May not contain embedded spaces or other characters not listed. 

 12.8 Total number of characters for each entry in the csv file in this column may not exceed 

15, including leading blanks or zeroes. 

13  Column L must contain an account description up to 30 characters. 

 Trailing blanks are not considered in the allowed length of the description 

 


